IMPLEMENTATION OF FUZZY MODELING FOR EFFICIENCY ENHANCEMENT IN DC MOTOR

Amit Kumar
Department of Electrical Engineering
Nagaji Institute of Technology and Management
Gwalior, India

Prof. Rekha Kushwaha
Department of Electrical Engineering
Nagaji Institute of Technology and Management
Gwalior, India

Prof. Rameshwar
Head of Department
Department of Electrical Engineering
Nagaji Institute of Technology and Management
Gwalior, India

ABSTRACT
This research paper an extensive study to control speed of dc motor by different Controller like PID or FUZZY Sliding mode in MATLAB simulation as well as experimental Study on dcmotor. The system identification technique is used to get the accurate transfer function of dc motor system identification is the technique where we give some input to the motor and

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India
get output corresponding input and output we get the process model with measured and
simulation mode through is model get the best fit percentage result after find the transfer
function of plant we have design the different controller to control the speed/position of the
motor. We have design PID controller or FUZZY controller for high accuracy speed control.

Keywords – Fuzzy Controller, DC Motor, PID Controller

INTRODUCTION
A dc motor is a machine or device which converts d.c power into mechanical power. Its
operation is based on the principle that when a current carrying conductor is placed in a
magnetic field, the conductor experiences a mechanical force. The direction of force is given
by Fleming’s left hand rule and magnitude is given by $F = Bil$ newtons, where “$B$” is magnetic
flux density, “$i$” is the current flowing through the conductor and “$l$” is the length of the
conductor. The output of the motor is a mechanical output that is the output is a rotational
motion of the rotor due to this force. A shaft is connected to the rotor and the shaft rotates.
The speed of rotation depends on various factors. Eg….The speed control can be done by
controlling those factors.

In the Flux control method speeds higher than the normal speed can be obtained and there is a
limit to the maximum speed obtainable by this method. It is because if the flux is too much
weakened, commutation becomes poorer. In the armature control method a large amount of
power is wasted due to which the output and the efficiency decrease. Hence speed regulation
is poorer. Voltage control method avoids the disadvantages of poor speed regulation and low
efficiency as in armature control method. This method is employed for large size of motors
where efficiency has a great importance. So here we use the voltage control method for the
speed control.

Proportional-Integral-Derivative (PID) controller has been used for several decades in
industries for process control applications. The combination of proportional, integral and

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India
derivative control action is called PID control action. PID controllers are commonly used to regulate the time-domain behaviour of many different types of dynamic plants. These controllers are extremely popular because they can usually provide good closed-loop response characteristics. The major merit of Fuzzy controller over PI controller is use of linguistic variable and user defined rule base that makes it possible to incorporate human intelligence in the controller. Fuzzy logic based controller also has the capability to control both linear and nonlinear system. Inputs given to the fuzzy logic based controller are speed error (e) and change in speed error (Δe). And output is the change of control (ωsl), which is the frequency correction. So the inputs error and change in error are processed according to the rule base, which is user defined and output correction is provided to the inverter. The membership functions and the rules are defined in FIS editor window. Based on rules, control surface is also generated. The system or model for speed controlling of induction drive is simulated both with PID and Fuzzy controller and results are analyzed and compared and Fuzzy controller is found to perform better than the conventional PID controller.

DC motors is used in many industrial applications such as electric vehicles, steel rolling mills, electric cranes, and robotic manipulators due to precise, wide, simple, and continuous control characteristics.

SPEED CONTROL OF DC MOTORS.

The expression of speed of a DC motor is given as:

\[ N=\frac{(V-I_R\mathcal{R})/\mathcal{O}}{k} \times k \]

Therefore speed of DC motor can be varied by controlling the following quantities

- *External resistance in armature circuit R*
- *Flux per pole \( \phi \)*
- *Voltage of the armature V*

Armature resistance control:
In this method armature circuit is provided with a variable resistance. Field is directly connected across the supply so that flux is not changed due to variation of series resistance. This is applied for dc shunt motor. This method is used in printing press, cranes, hoists where speeds lower than rated is used for a short period only.

\[
N \mu V - I_a (R_a + R_c)
\]

where \( R_c \) = controller resistance

Due to voltage drop in the controller resistance, the back e.m.f. (\( E_b \)) is decreased. Since \( N \mu \) \( E_b \), the speed of the motor is reduced. The highest speed obtainable is that corresponding to \( RC = 0 \) i.e., normal speed. Hence, this method can only provide speeds below the normal speed.

**Merits:**
- The ability to achieve speeds below the basic speed.
- Simplicity and ease of connection.
- The possibility of combining the functions of motor starting with speed control.

**Demerits**
• The relatively high cost of large, convinsulyrated, variable resistors capable of dissipating large amounts of power.
• Poor speed regulation for any given no load speed setting.
• Low efficiency resulting in high operating cost.
• Difficulty in obtaining stepless control of speed in higher power ratings.

Field Flux Control
It is based on the fact that by varying the flux $\phi$, the motor speed ($N \propto I/\phi$) can be changed and hence the name flux control method. In this method speed variation is accomplished by means of a variable resistance inserted in series with the shunt field. An increase in controlling resistances reduces the field current with a reduction in flux and an increase in speed. This method of speed control is independent of load on the motor. Power wasted in controlling resistance is very less as field current is a small value. This method of speed control is also used in DC compound motor.

![Field Flux Control Diagram]

Fig 2 - Field Flux Control

Merits:
• Good working efficiency.
• Compact controlling equipment
- The speed is not affected by load and speed control can be performed effectively even at light loads.
- Relatively inexpensive and simple to accomplish both manually and automatically.

**Demerits:**
- Inability to obtain prefet below the basic speed.
- Instability at high speeds because of armature reaction.
- Commutation difficulties and possible commutator damage at high speeds.

**Voltage control method**
In this method, the voltage source supplying the field current is different from that which supplies the armature. This method avoids the disadvantages of poor speed regulation and low efficiency as in armature control method. However, it is quite expensive. Therefore, this method of speed control is employed for large size motors where efficiency is of great importance.

When the speed is controlled by regulating the motor terminal voltage while maintaining constant field current, it is called voltage control. With voltage control, the change in speed is almost proportional to the change in voltage. The output varies directly with speed and the torque remains constant. Since the voltage has to be regulated without affecting the field, the application of voltage control is limited to separately excited motors.

**Multiple Voltage Control**
In this method, the shunt field of the motor is connected permanently across a fixed voltage source. The armature can be connected across several different voltages through suitable switchgear. In this way, voltage applied across the armature can be changed. The speed will be approximately proportional to the voltage applied across the armature. Intermediate speeds can be obtained by means of a shunt field regulator.
Ward-Leonard system
In this method, the adjustable voltage for the armature is obtained from an adjustable-voltage generator while the field circuit is supplied from a separate source. The armature of the shunt motor M (whose speed is to be controlled) is connected directly to a d.c. generator G driven by a constant-speed a.c. motor A. The field of the shunt motor is supplied from a constant-voltage exciter E. The field of the generator G is also supplied from the exciter E. The voltage of the generator G can be varied by means of its field regulator. By reversing the field current of generator G by controller FC, the voltage applied to the motor may be reversed. Sometimes, a field regulator is included in the field circuit of shunt motor M for additional speed adjustment. With this method, the motor may be operated at any speed above its maximum speed.

![Ward-Leonard system diagram]

**Fig. 3 - Ward-Leonard system**

DC MOTOR MODEL:
A common actuator in control systems is the DC motor. It directly provides rotary motion and, coupled with wheels or drums and cables, can provide translational motion. The electric circuit of the armature and the free-body diagram of the rotor are shown in the following fig 3.1:
Here we assume that the input of the system is the voltage source (V) applied to the motor's armature, while the output is the rotational speed of the shaft d(\theta)/dt. The rotor and shaft are assumed to be rigid. We further assume a viscous friction model, that is, the friction torque is proportional to shaft angular velocity.

In general, the torque generated by a DC motor is proportional to the armature current and the strength of the magnetic field. In this example we will assume that the magnetic field is constant and, therefore, that the motor torque is proportional to only the armature current i by a constant factor \( K_t \) as shown in the equation below. This is referred to as an armature-controlled motor.

\[
T = K_t i
\]  

(1)

The back emf, \( e \), is proportional to the angular velocity of the shaft by a constant factor \( K_e \).

\[
e = K_e \dot{\theta}
\]  

(2)

In SI units, the motor torque and back emf constants are equal, that is, \( K_t = K_e \); therefore, we will use \( K \) to represent both the motor torque constant and the back emf constant.

**BUILDING THE MODEL IN SIMULINK:**
This system will be modelled by summing the torques acting on the rotor inertia and integrating the acceleration to give velocity. Also, Kirchhoff’s laws will be applied to the armature circuit. First, we will model the integrals of the rotational acceleration and of the rate of change of the armature current.

\[ \int \frac{d^2 \theta}{dt^2} \, dt = \frac{d\theta}{dt} \]  
\[ \int \frac{di}{dt} \, dt = i \]  

(3)  
(4)

To build the simulation model, we open Simulink and open a new model window. Then we insert the integrator block from the Simulink continuous library. The model appears as

Next, we will apply Newton's law and Kirchhoff’s law to the motor system to generate the following equations:

\[ J \frac{d^2 \theta}{dt^2} = T - \frac{6}{J} \frac{d\theta}{dt} \implies \frac{d^2 \theta}{dt^2} = \frac{1}{J} (Kei - \frac{6}{J} \frac{d\theta}{dt}) \]  
\[ L \frac{di}{dt} = -Ri + V - e \implies \frac{di}{dt} = \frac{1}{L} (-Ri + V - Ke \frac{d\theta}{dt}) \]  

(5)  
(6)
Continuing to model these equations in Simulink, we add two Gain blocks and two Add blocks from the Simulink library to obtain the model as shown.

Now, we add in the torques which is represented in the rotational equation. First, we add in the damping torque by inserting a gain block below the inertia block.

Next, we add in the torque from the armature by inserting a gain block attached to the positive input of the rotational Add block with a line.

The model appears as -
Now, we add in the voltage terms which are represented in the electrical equation. First, we add in the voltage drop across the armature resistance by inserting a gain block above the inductance block. Next, we add in the back emf from the motor by inserting a gain block attached to the other negative input of the current add block.

Finally we add In1 and Out 1 blocks from the simulink and subsystems library and respectively label them “Voltage” and “Speed”

The final design should look like the figure below.
In order to save all of these components as a single subsystem block, we first select all of the blocks, then select Create Subsystem from the Edit menu. We name the subsystem "DC Motor" and then save the model.

**Fig 5 - SIMULINK model of the DC motor**

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India
We then extract the model into MATLAB to run for the desired values. We need to identify the inputs and outputs of the model we wish to extract. First we right-click on the signal representing the Voltage input in the Simulink model.

Then choose Linearization > Input Point from the resulting menu. Similarly, right-click on the signal representing the Speed output and select Linearization > Output Point from the resulting menu. The input and output signals should now be identified on your model by arrow symbols as shown in the figure below.

![SIMULINK model with input and output](image)

**Fig 5 : SIMULINK model with input and output**

**ANALYSIS OF THE DC MOTOR MODEL:**

In order to perform the extraction, we select from the model window Tools > Control Design > Linear Analysis. We then linearize the model to obtain the step response of the model.

The design requirements of the systems may vary from one system to another. For our case, we want a fast response of the system to an error. The overshoot of the system should not be higher than 5% and the settling time should be smaller than 2 seconds.

The main design requirements are as follows:
Settling time should be less than 2 seconds;
Overshoot of the system should be less than 5%;
Steady state error should be less than 1%

By varying the values of the parameters in the m-file we obtain the desired step response curve as shown

From the graph the values obtained are
Rise time = 1.14
Settling time = 2.07
Steady state value = 0.099

From the above values obtained we see that the response is obtained not within the desired design parameters. As such we have to use the controllers for better responses.

**PID CONTROLLER**

*Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India*
The combination of proportional, integral and derivative control action is called PID control action. PID controllers are commonly used to regulate the time-domain behaviour of many different types of dynamic plants.

These controllers are extremely popular because they can usually provide good closed-loop response characteristics.

We consider the feedback system architecture where it can be assumed that the plant is a DC motor whose speed must be accurately regulate.

The output of a PID controller, equal to the control input to the plant, in the time-domain is as follows:

\[ u(t) = K_p e(t) + K_i \int e(t) dt + K_d \frac{de}{dt} \]

The variable \( e \) represents the tracking error, the difference between the desired input value \( r \) and the actual output \( y \). This error signal \( e \) will be sent to the PID controller, and the controller computes both the derivative and the integral of this error signal. The control signal \( u \) to the plant is equal to the proportional gain \( K_p \) times the magnitude of the error plus the integral gain \( K_i \) times the integral of the error plus the derivative gain \( K_d \) times the derivative of the error.
This control signal \( u(t) \) is sent to the plant, and the new output \( y(t) \) is obtained. The new output \( y(t) \) is then fed back and compared to the reference to find the new error signal \( e(t) \). The controller takes this new error signal and computes its derivative and its integral again, ad infinitum.

PID controller can be investigated under three main categories. Each controller has different properties in terms of controlling the whole system.

In proportional control, adjustments are based on the current difference between the actual and desired speed.

In integral control, adjustments are based on recent errors.

In derivative control, adjustments are based on the rate of change of errors.

**The Characteristics of P, I, and D Controllers**

A proportional controller \( (K_p) \) will have the effect of reducing the rise time and will reduce but never eliminate the steady-state error. An integral control \( (K_i) \) will have the effect of eliminating the steady-state error for a constant or step input, but it may make the transient response slower. A derivative control \( (K_d) \) will have the effect of increasing the stability of the system, reducing the overshoot, and improving the transient response.

The effects of each of controller parameters, \( K_p, K_d, \) and \( K_i \) on a closed-loop system are summarized in the table below:

<table>
<thead>
<tr>
<th>Closed Loop Response</th>
<th>Rise Time</th>
<th>Overshoot</th>
<th>Settling Time</th>
<th>Steady State error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kp</td>
<td>Decrease</td>
<td>Increase</td>
<td>Small Change</td>
<td>Decrease</td>
</tr>
</tbody>
</table>
MODEL THE PID WITH DC MOTOR:
The actual output value is fed back to the system which is then compared to the desired input. The error is then fed to the PID controller unit as input to it and hence we get the new output.

<table>
<thead>
<tr>
<th>Ki</th>
<th>Decrease</th>
<th>Increase</th>
<th>Increase</th>
<th>Eliminate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kd</td>
<td>Small Change</td>
<td>Decrease</td>
<td>Decrease</td>
<td>No Change</td>
</tr>
</tbody>
</table>

Here we remove the input to the system and implement a controller to the system. A PID controller is employed from the continuous library of Simulink.

We then add the sum block from the library. We extend to it the feedback from the DC subsystem.

We then introduce the step input to the sum. We finally add a scope to the output to view the desired responses.

Finally the SIMULINK model of a PID controller for DC motor speed control is as shown.
**Fig 10:** SIMULINK model of a DC MOTOR having PID controller

The inner view of the controller is

**FIG11:**- simulink model of a PID controller

**Analysis of PID Controller**

For a 1-rad/sec step reference, the design criteria are the following.

- Settling time less than 2 seconds
- Overshoot less than 5%
- Steady-state error less than 1%
We then create the input and output points by right clicking and choosing Linearization>Input/output points on the reference signal and the signal to the scope.

We perform the extraction by choosing Tools>Control Design>Linear Analysis. We then linearize the model to obtain the desired step response.

**Analysis for different values of the parameters of PID controller:**

We now change the values of the PID parameters Kp, Kd and Ki to obtain the various responses.

For Ki=1, Kd=1, Kp=100:

With these values the response obtained is shown below.

![Step response for Ki=1, Kd=1, Kp=100](image)

It is seen that we have a very high settling time, which don’t satisfy the design criteria.

We have rise time = 0.119

To improve this we increase the value of Ki.
for Ki=100, Kd=1, Kp=100

With these values the response obtained is shown below

![Fig 8: step response for Ki=100, Kd=1 and Kp=100](image)

As we increase the value of Ki, the steady state error becomes zero, which satisfies the purpose of adding the integral controller.

We have rise time = 0.11sec and settling time = 0.987sec

Ki=200, Kd=1, Kp=100

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India
Fig. 9 - step response for Ki=200, Kd=1, Kp=100

Rise time: 0.102 sec
Settling time: 0.581 sec
But the overshoot obtained doesn’t satisfy the design criteria.
As such we increase the value of Kd.

Ki=200, Kd=10, Kp=100
With these values the response obtained is as shown.

Fig 10 - step response for Ki=200, Kd=10 and Kp=100

Now as we increase the value of Kd, the overshoot becomes zero.

Also the steady state error becomes zero.

We have the settling time = 0.266sec and rise time = 0.109sec.

These values satisfy the design criteria.

**Analysis of the model with the help of a constant speed:**

We remove the step response block, instead of that we add a constant speed 1500 block to analysis the model and compare response. The model is shown as
FIG 11 - simulink model of a dc motor having constant speed block

the response for this model will look like as same as previous response. the response is shown below.
Response in various forms look like as shown:

Fig12 - step response for $K_i=200$, $K_d=10$ and $K_p=100$

![Step Response Graph](image)

Fig13 - Impulse response for $K_i=200$, $K_d=10$ and $K_p=100$

![Impulse Response Graph](image)
DESIGN OF MEMBERSHIP FUNCTION (MF)

Input Variables

(a) Fuzzy Sets of Speed Error (E) Variable

<table>
<thead>
<tr>
<th>Fuzzy set (Label)</th>
<th>Description</th>
<th>Numerical Range</th>
<th>Shape of Membership</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative large (NL)</td>
<td>Large Speed difference in negative direction</td>
<td>-20 to -20, -20 to 40</td>
<td>Triangular</td>
</tr>
</tbody>
</table>

Fig. 14 - Pole zero map for Ki=200, Kd=10 and Kp=100
(b) Fuzzy Sets Of Change In Speed Error (De) Variable

Table 4 Membership function of change in speed error

<table>
<thead>
<tr>
<th>Fuzzy set (Label)</th>
<th>Description</th>
<th>Numerical Range</th>
<th>Membership Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative large (NL)</td>
<td>Large error difference in negative direction</td>
<td>-1300 to -1300</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-1300 to -800</td>
<td></td>
</tr>
<tr>
<td>Negative small (NS)</td>
<td>Small error difference in negative direction</td>
<td>-1050 to -50</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-800 to -500</td>
<td></td>
</tr>
<tr>
<td>Zero (ZE)</td>
<td>Error difference is zero</td>
<td>-800 to -550</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-550 to -200</td>
<td></td>
</tr>
<tr>
<td>Positive Small (PL)</td>
<td>Small error difference in positive direction</td>
<td>-800 to -300</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-300 to -50</td>
<td></td>
</tr>
<tr>
<td>Positive large (PS)</td>
<td>Large error difference in positive direction</td>
<td>-300 to -300</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-300 to 200</td>
<td></td>
</tr>
</tbody>
</table>

Output Variables

(a) Fuzzy sets for $K_P$

Table 5 Membership function of proportional gain $K_P$

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India
### Table 6 Membership function of integral gain $K_i$

<table>
<thead>
<tr>
<th>Fuzzy set (Label)</th>
<th>Numerical Range</th>
<th>Membership function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive very small (PVS)</td>
<td>0 to 0</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td>0 to 10</td>
<td></td>
</tr>
<tr>
<td>Positive Small (PS)</td>
<td>0 to 5</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td>5 to 15</td>
<td></td>
</tr>
<tr>
<td>Positive Medium small (PMS)</td>
<td>5 to 10</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td>10 to 20</td>
<td></td>
</tr>
<tr>
<td>Positive Medium (PM)</td>
<td>10 to 15</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td>15 to 20</td>
<td></td>
</tr>
<tr>
<td>Positive Medium Large (PML)</td>
<td>10 to 20</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td>20 to 25</td>
<td></td>
</tr>
<tr>
<td>Positive Large (PL)</td>
<td>15 to 25</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td>25 to 30</td>
<td></td>
</tr>
<tr>
<td>Positive very Large (PVL)</td>
<td>20 to 30</td>
<td>Triangular</td>
</tr>
<tr>
<td></td>
<td>30 to 30</td>
<td></td>
</tr>
</tbody>
</table>

(b) Fuzzy sets for $K_i$
(c) Fuzzy Sets for $K_D$

Table 7 Membership function for derivative gain $K_d$

<table>
<thead>
<tr>
<th>Fuzzy set (Label)</th>
<th>Numerical Range</th>
<th>Shape of Membership function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive very small (PVS)</td>
<td>0 to 0 0 to 2</td>
<td>Triangular</td>
</tr>
<tr>
<td>Positive Small (PS)</td>
<td>0 to 1 1 to 3</td>
<td>Triangular</td>
</tr>
<tr>
<td>Positive Medium small (PMS)</td>
<td>1 to 2 2 to 4</td>
<td>Triangular</td>
</tr>
<tr>
<td>Positive Medium (PM)</td>
<td>2 to 3 3 to 4</td>
<td>Triangular</td>
</tr>
<tr>
<td>Positive Medium Large (PML)</td>
<td>2 to 4 4 to 5</td>
<td>Triangular</td>
</tr>
<tr>
<td>Positive Large (PL)</td>
<td>3 to 5 5 to 6</td>
<td>Triangular</td>
</tr>
<tr>
<td>Positive very Large (PVL)</td>
<td>4 to 6 6 to 6</td>
<td>Triangular</td>
</tr>
</tbody>
</table>

DESIGN OF FUZZY RULES

(a) Rule Bases for Tuning $K_p$

<table>
<thead>
<tr>
<th>de/e</th>
<th>NL</th>
<th>NS</th>
<th>ZE</th>
<th>PS</th>
<th>PL</th>
</tr>
</thead>
<tbody>
<tr>
<td>NL</td>
<td>PVL</td>
<td>PVL</td>
<td>PVL</td>
<td>PVL</td>
<td>PVL</td>
</tr>
</tbody>
</table>

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India
<table>
<thead>
<tr>
<th></th>
<th>NS</th>
<th>PML</th>
<th>PML</th>
<th>PML</th>
<th>PL</th>
<th>PVL</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZE</td>
<td>PVS</td>
<td>PVS</td>
<td>PS</td>
<td>PMS</td>
<td>PMS</td>
<td></td>
</tr>
<tr>
<td>PS</td>
<td>PML</td>
<td>PML</td>
<td>PML</td>
<td>PL</td>
<td>PVL</td>
<td></td>
</tr>
<tr>
<td>PL</td>
<td>PVL</td>
<td>PVL</td>
<td>PVL</td>
<td>PVL</td>
<td>PVL</td>
<td></td>
</tr>
</tbody>
</table>

(b) Rule bases for tuning $K_i$

<table>
<thead>
<tr>
<th>de/e</th>
<th>NL</th>
<th>NS</th>
<th>ZE</th>
<th>PS</th>
<th>PL</th>
</tr>
</thead>
<tbody>
<tr>
<td>NL</td>
<td>PM</td>
<td>PM</td>
<td>PM</td>
<td>PM</td>
<td>PM</td>
</tr>
<tr>
<td>NS</td>
<td>PMS</td>
<td>PMS</td>
<td>PMS</td>
<td>PMS</td>
<td>PMS</td>
</tr>
<tr>
<td>ZE</td>
<td>PS</td>
<td>PS</td>
<td>PVS</td>
<td>PS</td>
<td>PS</td>
</tr>
<tr>
<td>PS</td>
<td>PMS</td>
<td>PMS</td>
<td>PMS</td>
<td>PMS</td>
<td>PMS</td>
</tr>
<tr>
<td>PL</td>
<td>PM</td>
<td>PM</td>
<td>PM</td>
<td>PM</td>
<td>PM</td>
</tr>
</tbody>
</table>

(c) Rule Bases for tuning $K_d$

<table>
<thead>
<tr>
<th>de/e</th>
<th>NL</th>
<th>NS</th>
<th>ZE</th>
<th>PS</th>
<th>PL</th>
</tr>
</thead>
<tbody>
<tr>
<td>NL</td>
<td>PVS</td>
<td>PMS</td>
<td>PM</td>
<td>PL</td>
<td>PVL</td>
</tr>
</tbody>
</table>
FUTURE SCOPE
MATLAB simulation for speed control of separately excited DC motor has been done which can be implemented in hardware to observe actual feasibility of the approach applied in this thesis. This technique can be extended to other types of motors. The parameters of PID controller can also be tuned by using genetic algorithm (GA). In large, complex system the behaviour of the system is difficult to determine and it may suffer system non linearities such like saturation, dead zone etc which degraded the performance of conventional PID controller. Such non linearities can be reduced by using fuzzy based PID controller. Moreover conventional PID controller required manual tuning while fuzzy based PID controller operates automatically.

REFERENCES

Approved by Council of Scientific and Industrial Research, Ministry of Science and Technology, Govt. of India


